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Safety Information

The attached "Safety Precautions" manual contains important information about the safe and correct
use of the ScanSnap. Make sure that you read and understand it before using the ScanSnap.

Safety Information
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Manuals

Read the following manuals according to your needs when using the ScanSnap.

Before Using the ScanSnap
Manual Description and Location

Safety Precautions This manual contains important information about the safe use of the ScanSnap.
Make sure you read this manual before using the ScanSnap.
This manual is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [S1100i Safety Precautions].

When Setting Up the ScanSnap
Manual Description and Location

ScanSnap S1100i Getting
Started

This manual explains the setup procedure from the moment you open the package to
testing the operations.
Getting Started is included in the package.

In addition, when the software is already installed, this manual can be accessed as
follows: From the sidebar in Finder, select [Applications] → [ScanSnap Manuals], and
then double-click [S1100i Getting Started].

When Operating the ScanSnap
Manual Description and Location

ScanSnap S1100i Basic
Operation Guide (this
manual)

This manual explains the basic operations and cleaning procedure for the ScanSnap.

ScanSnap Advanced
Operation Guide

This manual describes operations including various scanning methods and useful
usages of the ScanSnap.
You can refer to this manual at the following website.
http://www.pfu.fujitsu.com/imaging/downloads/manual/advanced/mac/en/common/
index.html

ScanSnap Manager Help This Help file describes the windows, operational troubles and the solutions, as well as
messages of the ScanSnap Manager.
This manual can be accessed by one of the following methods:

l Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and select [Help] → [Help] from the "ScanSnap
Manager Menu" (page 39).

l Click the Help button ( ) for ScanSnap Manager.
l Select [Help] in the menu bar → [ScanSnap Manager Help].

Manuals
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When Saving Scanned Images to a Mobile Device
Manual Description and Location

ScanSnap Basic Operation
Guide (Mobile Connection
for iOS)

This manual describes operations to be performed on an iOS-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The [Information] screen appears.

3. Tap the [Help] button.

ScanSnap Basic Operation
Guide (Mobile Connection
for Android)

This manual describes operations to be performed on an Android-based mobile device
when you save scanned images to the mobile device.
This manual can be accessed by the following method:
1. Start up ScanSnap Connect Application on the mobile device.
a The [File List] screen appears.

2. Tap .
a The menu appears.

3. Tap [Help].

When Updating the Software
Manual Description and Location

ScanSnap Online Update
Help

This Help file describes the operations, windows, and messages of ScanSnap Online
Update.
This Help file can be accessed by one of the following methods:

l Click the Help button ( ) of ScanSnap Online Update.
l Select [Help] in the menu bar → [ScanSnap Online Update Help].

When Using Related Applications
Manual Description and Location

ScanSnap Organizer Help This Help file describes the operations, windows, and messages of ScanSnap
Organizer.
This Help file can be accessed by selecting [Help] in the menu bar → [ScanSnap
Organizer Help].

CardMinder Help This Help file describes the operations, windows, and messages of CardMinder.
This Help file can be accessed by selecting [Help] in the menu bar → [CardMinder
Help].

Manuals
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Trademarks

Microsoft, Windows, Windows Vista, Excel, PowerPoint, Outlook, SharePoint, Windows Live,
Internet Explorer, and OneDrive are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Word is the product of Microsoft Corporation in the United States.

Apple, App Store, the Apple logo, Mac, Mac OS, OS X, macOS, iPad, iPhoto, iPod touch, and
iTunes are trademarks of Apple Inc.

Intel and Intel Core are registered trademarks or trademarks of Intel Corporation in the United States
and other countries.

ABBYY™ FineReader™ Engine © ABBYY. OCR by ABBYY

ABBYY and FineReader are trademarks of ABBYY Software, Ltd. which may be registered in some
jurisdictions.

Evernote is a registered trademark or trademark of Evernote Corporation.

Google, Android, Google Play, and Google Drive are registered trademarks or trademarks of Google
Inc. Use of these registered trademarks or trademarks is subject to Google Permissions.

Salesforce, the Salesforce logo, and Salesforce CRM are registered trademarks or trademarks of
salesforce.com, inc. in the United States and other countries.

Wi-Fi, Wi-Fi Protected Setup, and the Wi-Fi Protected Setup logo are trademarks of Wi-Fi Alliance.

ScanSnap, the ScanSnap logo, ScanSnap Manager, ScanSnap Organizer, CardMinder, and Rack2-
Filer are registered trademarks or trademarks of PFU Limited in Japan.

Other company names and product names are the registered trademarks or trademarks of the
respective companies.

Trademarks
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Manufacturer

PFU Limited

YOKOHAMA i-MARK PLACE, 4-4-5 Minatomirai, Nishi-ku, Yokohama, Kanagawa, 220-8567, Japan

© PFU Limited 2014-2017
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Symbols Used in This Manual

The following indications are used in this manual to obviate any chance of accident or damage to
you and people near you, and your property. Warning labels indicate the warning level and
statements. The symbols indicating warning levels and their meanings are as follows.

Indication Description

�������

This indication alerts operators of an operation that, if not strictly observed, may result
in safety hazards to personnel or damage to the product.

Symbols Used in This Manual
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Arrow Symbols in This Manual

Right-arrow symbols (→) are used to connect icons or menu options you should select in
succession.

Example: From the sidebar in Finder, select [Applications] → [ScanSnap].

Arrow Symbols in This Manual
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Screen Examples in This Manual

The screenshots used in this manual are of OS X El Capitan v10.11.

The actual windows and operations may differ depending on the operating system.

The screen examples in this manual are subject to change without notice in the interest of product
development.

If the actual window differs from the screen examples in this manual, operate by following the actual
displayed screen.

Screen Examples in This Manual
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Abbreviations Used in This Manual

Also, the following abbreviations are used in this manual.

Abbreviation Used Designation

Mac OS macOS High Sierra v10.13
macOS Sierra v10.12
OS X El Capitan v10.11

Word Microsoft® Word 2016 for Mac
Microsoft® Word for Mac 2011

Excel Microsoft® Excel® 2016 for Mac
Microsoft® Excel® for Mac 2011

PowerPoint Microsoft® PowerPoint® 2016 for Mac
Microsoft® PowerPoint® for Mac 2011

ABBYY FineReader for
ScanSnap

ABBYY FineReader for ScanSnap™
All the descriptions in this manual assume the usage of ABBYY FineReader for
ScanSnap bundled with the ScanSnap. Unless otherwise specified, the term ABBYY
FineReader for ScanSnap refers to the ABBYY FineReader for ScanSnap bundled
with the ScanSnap.
Note that ABBYY FineReader for ScanSnap may be upgraded without notice. If the
descriptions in this manual differ from the actual displayed screens, refer to the
ABBYY FineReader for ScanSnap User's Guide.

Google Drive Google Drive™
Android Android™
ScanSnap Color Image Scanner ScanSnap S1100i

Carrier Sheet ScanSnap Carrier Sheet

Abbreviations Used in This Manual
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What You Can Do with the ScanSnap

Scanning Multiple Documents Continuously
When you scan multiple documents with the ScanSnap, you can scan one or two document at a
time. To scan two documents at a time, you can insert two documents at a time or you can insert the
next document while another document is being scanned.

l Scanning one document at a time

After scanning a document is completed, when you insert the next document in the ScanSnap,
the next scan is started automatically.

For details, refer to "Scanning a Document" (page 17).

l Scanning documents by inserting two documents at a time or by inserting the next document
while the current document is being scanned (dual scan)

When scanning small size documents such as business cards and postcards, you can insert two
documents at a time in the ScanSnap. Alternatively, you can insert the next document while
another document is being scanned. In either method, you can scan up to 20 documents
continuously in a single scanning operation.

These scanning methods are referred to as dual scans.

For details, refer to "Scanning Documents with the ScanSnap by Inserting Two Documents at a
Time or by Inserting the Next Document While the Current Document Is Being Scanned" (page
22).

Scanning Documents Larger Than A4 or Letter Size by Directly
Inserting Them in the ScanSnap
By folding an A3, B4, or Double Letter size document in half and scanning each side continuously,
the scanned images of both sides can be automatically merged into a single image.

What You Can Do with the ScanSnap
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Scanned images can be merged only when there is text, diagram, or a table on the fold line of the
folded document.

For details, refer to "Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them
in the ScanSnap)" (page 28).

Scanning Documents That Cannot Be Inserted Directly in the
ScanSnap
You can use the optional Carrier Sheet to scan the following documents.

l Documents that are larger than A4/Letter size and not larger than A3 size

For details, refer to "Scanning Documents Larger Than A4 or Letter Size (with the Carrier
Sheet)" (page 74).

l Documents that can be damaged quite easily such as photographs, or non-standard size
documents such as clippings

For details, refer to "Scanning Documents Such as Photographs and Clippings" (page 79).

What You Can Do with the ScanSnap
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Scanning a Document

The procedure for scanning documents by inserting one document at a time is as follows.

For details about documents that can be scanned, refer to "Documents to Scan" (page 47).

1. Open the feed guide of the ScanSnap.

Feed Guide

HINT
l If you want the document to be ejected from the front of the ScanSnap or when there is not

enough space where the document exits the ScanSnap, open the output guide.
For details about documents that can be scanned with the output guide open, refer to
"Documents to Scan" (page 47).

Output Guide

l How the document is ejected differs as below depending on whether the output guide is open
or closed.
- When the output guide is closed

- When the output guide is open

a The [Scan/Stop] button flashes in blue. The button returns to being lit normally when
document scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

Scanning a Document
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2. Insert the document straight into the feeding section of the ScanSnap, with
the scanning side facing up.

a The document is pulled in until it is set inside the ScanSnap.

ATTENTION
l If you specify a standard size instead of selecting [Automatic detection] (default), insert the

document by aligning it with the left edge of the feeding section.
You can configure the scan settings in the "ScanSnap Setup Window" (page 41).

l When you perform scanning with the output guide closed, leave enough space at the back of
the ScanSnap to allow the document to be completely ejected. In addition, when you scan
long page documents, hold the scanned documents with your hands to prevent them from
falling off the unit where the ScanSnap is placed on.
Make sure that the area where the document exits the scanner is clear of any obstacles.
Otherwise, paper jam may occur.

l If you scan the following documents with the output guide open, a paper jam may occur and
damage the documents. Scan the following documents with the output guide closed.

- Thick paper (80 g/m2 [20 lb] or heavier)
- Postcards

Scanning a Document
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- Business cards
- Plastic cards
- Carrier Sheet

Output Guide

3. Press the [Scan/Stop] button on the ScanSnap to start scanning.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.
l Close the feed guide.
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan/Stop] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

a When scanning is complete, the [ScanSnap Manager - Image scanning and file saving]
window displays a scanning standby status.

Scanning a Document
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HINT
To continue scanning, insert the next document to be scanned. When the document is inserted,
scanning starts automatically.

4. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
a The Quick Menu appears.

5. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.
For details about linking the following applications with ScanSnap Manager, refer to "Useful
Usages" (page 67).

l ScanSnap Organizer

l CardMinder

Scanning a Document
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning a Document
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Scanning Documents with the ScanSnap by
Inserting Two Documents at a Time or by
Inserting the Next Document While the Current
Document Is Being Scanned

When scanning small size documents such as business cards and postcards with the ScanSnap,
you can insert two documents at a time or you can insert the next document while the current
document is being scanned. These scanning methods are referred to as dual scans.

Documents can be inserted in the following two methods:

l Inserting two documents at a time in the ScanSnap

l Inserting the next document while the current document is being scanned

For details about documents that can be scanned, refer to "Documents to Scan" (page 47).

ATTENTION
l When you select an option other than [Automatic detection] for [Paper size] in the [Paper] tab of the

"ScanSnap Setup Window" (page 41), the dual scan function is disabled.
l Use a dual scan to scan a document within the following ranges. If one of the following ranges is

exceeded, a length error occurs and part of the document may not appear in the scanned image.
- Maximum scanning length: 863 mm (34 in.) (355.6 mm (14 in.) when [Excellent] is specified for

[Image Quality] in the [Scanning] tab of the "ScanSnap Setup Window" (page 41))
- Maximum number of documents for scanning: 20 sheets

l When you continue scanning by inserting the next document while the current document is being
scanned, the [Scan/Stop] button flashes more quickly if the scanning length exceeds 650 mm (26

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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in.). If this occurs, wait until scanning is complete without continuing to insert more documents.
After scanning is complete, insert the next document. The next scan is started automatically.

1. Open the feed guide of the ScanSnap.

Feed Guide

HINT
l If you want the document to be ejected from the front of the ScanSnap or when there is not

enough space where the document exits the ScanSnap, open the output guide.
For details about documents that can be scanned with the output guide open, refer to
"Documents to Scan" (page 47).

Output Guide

l How the document is ejected differs as below depending on whether the output guide is open
or closed.
- When the output guide is closed

- When the output guide is open

a The [Scan/Stop] button flashes in blue. The button returns to being lit normally when
document scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Insert the document straight into the feeding section of the ScanSnap, with
the scanning side facing up.
Insert each document in the center of the left or right half of the feeding section.

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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ATTENTION
When inserting the documents, insert them at least 10 mm (0.39 in.) apart from each other. If the
space between the documents is less than 10 mm (0.39 in.), the scanned images may not be
cropped correctly.

a The document is pulled in until it is set inside the ScanSnap.

ATTENTION
l When you perform scanning with the output guide closed, leave enough space at the back of

the ScanSnap to allow the document to be completely ejected. In addition, when you scan
long page documents, hold the scanned documents with your hands to prevent them from
falling off the unit where the ScanSnap is placed on.
Make sure that the area where the document exits the scanner is clear of any obstacles.
Otherwise, paper jam may occur.

l If you scan the following documents with the output guide open, a paper jam may occur and
damage the documents. Scan the following documents with the output guide closed.

- Thick paper (80 g/m2 [20 lb] or heavier)
- Postcards
- Business cards

Output Guide

3. Press the [Scan/Stop] button on the ScanSnap to start scanning.

ATTENTION
Do not perform the following operations during scanning. Doing so will stop scanning.
l Connect or disconnect the ScanSnap and other USB devices.

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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l Close the feed guide.
l Switch users.
l Allow the computer to enter sleep mode.

a The [Scan/Stop] button on the ScanSnap flashes in blue while the documents are being
scanned.

The [ScanSnap Manager - Image scanning and file saving] window appears.

HINT
When the [ScanSnap Manager - Image scanning and file saving] window is maximized,
multiple scanned images are displayed in the preview area. When you use a dual scan, it is
recommended that you maximize the [ScanSnap Manager - Image scanning and file saving]
window to check that scanned images are created correctly while scanning documents.

a When scanning is complete, the [ScanSnap Manager - Image scanning and file saving]
window displays a scanning standby status.

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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HINT
To continue scanning, insert the next document to be scanned. When the document is inserted,
scanning starts automatically.

4. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
a The Quick Menu appears.

5. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.
For details about linking the following applications with ScanSnap Manager, refer to "Useful
Usages" (page 67).

l ScanSnap Organizer

l CardMinder

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by Inserting the Next Document While the Current
Document Is Being Scanned
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Scanning Documents Larger Than A4 or Letter
Size (by Directly Inserting Them in the
ScanSnap)

By folding an A3, B4, or Double Letter size document in half and scanning each side continuously,
the scanned images of both sides are automatically merged and saved as a single image.

For details about documents that can be scanned, refer to "Documents to Scan" (page 47).

ATTENTION
l Scanned images are automatically merged only when there is text, diagram, or a table on the fold

line of the folded document.
- When scanned images are automatically merged

- When scanned images are not automatically merged

l After a document is scanned, if the scanned images cannot be merged automatically, you can use
ScanSnap Page Merger to merge the scanned images.
For details, refer to the ScanSnap Manager Help.

l For a document that will have scanned images which are merged automatically, you can use the
optional Carrier Sheet to scan the document and merge the scanned images automatically.
For details, refer to "Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)"
(page 74).

l If scanned images are unexpectedly merged, clear the [Merge both side images] checkbox on the
[Scanning mode option] window, and then scan the document again.
To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the
"ScanSnap Setup Window" (page 41).

Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)
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1. Open the feed guide of the ScanSnap.

Feed Guide

a The [Scan/Stop] button flashes in blue. The button returns to being lit normally when
document scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

2. Fold the document in half so that the sides to be scanned are facing out.

ATTENTION
Fold the long side of the document in half. If the left and right areas of the folded document are
different in size from each other, the scanned images may not be merged automatically.

3. Insert the document straight into the feeding section of the ScanSnap, with
the scanning side facing up.

a The document is pulled in until it is set inside the ScanSnap.

Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)
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HINT
If you scan a document folded in half with the output guide open, a paper jam may occur. Make
sure to close the output guide when you scan a document folded in half.

Output Guide

4. Press the [Scan/Stop] button on the ScanSnap to start scanning.
a The [Scan/Stop] button on the ScanSnap flashes in blue and the [ScanSnap Manager -

Image scanning and file saving] window appears while the document is being scanned.

When scanning is complete, the scanned image of the scanning side is displayed in the
preview area.

5. Turn over the document and insert it as described in step 3.

ATTENTION
Make sure to scan the front and back sides of the document folded in half consecutively.

a Scanning starts automatically.

HINT
Repeat steps 2 to 5 to continue scanning more A3, B4, or Double Letter size documents. You
can also continue scanning documents smaller than A4 or Letter size.
For details about scanning a document, refer to "Scanning a Document" (page 17).

6. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
a The Quick Menu appears.

Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)
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7. In the Quick Menu, click the icon of the application to link with ScanSnap
Manager.

When you select , you can manage scanned images by folder with ScanSnap
Organizer.

For details, refer to "Managing Paper Documents by Folder on a Computer" (page 68).

a The selected application starts up. For details, refer to the Advanced Operation Guide.

ATTENTION
l You cannot start scanning when the Quick Menu is displayed. Either select an icon from the

Quick Menu and finish the process, or close the Quick Menu before you perform the next
scan.

l Do not move, delete, or rename scanned images using other applications while the Quick
Menu is displayed.

HINT

l Clicking  displays the description of an application. Placing the mouse cursor over the
icon of another application displays the description of the application.

l Performing a scan while an application that can be automatically linked with is active
automatically starts the linkage between ScanSnap Manager and the application.
For details, refer to the Advanced Operation Guide.

Scanning Documents Larger Than A4 or Letter Size (by Directly Inserting Them in the ScanSnap)
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ScanSnap Overview

This section provides an overview that you should be aware of before operating ScanSnap.

l "Parts and Functions" (page 33)

l "System Requirements" (page 35)

l "Overview of the Software Related to the ScanSnap" (page 36)

l "How to Install the Software" (page 37)

l "ScanSnap Manager Icon" (page 38)

l "ScanSnap Manager Menu" (page 39)

l "ScanSnap Setup Window" (page 41)

l "Turning the ScanSnap On or Off" (page 42)

l "Documents to Scan" (page 47)

ScanSnap Overview
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Parts and Functions

This section explains the names and functions of the ScanSnap parts.

Front

3

1

2

4

5

No. Name Description

1 Feed guide Open it to use the ScanSnap.
Opening it turns on the ScanSnap. Then, you can place a document
on it to insert the document.

2 Output guide Open it to eject documents from the front of the ScanSnap.
Select an ejection method depending on the document type you are
scanning.
For details about documents that can be scanned with the
ScanSnap, refer to "Documents to Scan" (page 47).
l When the output guide is closed

l When the output guide is open

Parts and Functions
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No. Name Description

3 Top cover Open it to remove jammed documents or clean the inside of the
ScanSnap.
For details about how to clean the inside of the ScanSnap, refer to
"Cleaning the Inside of the ScanSnap" (page 93).

4 [Scan/Stop] button Press this button to start or finish scanning.
Indicates the status of the ScanSnap as follows:
Blue (lit): Ready
Blue (flashing): Scanning
Orange (flashing): Error

5 Feeding section Insert the document here to load.

Side

6

7

No. Name Description

6 Tape seal Remove this tape seal after installing the software.

7 USB connector Used to connect a USB cable.
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System Requirements

The ScanSnap has the following system requirements.

For the latest information on requirements, please visit the ScanSnap Support Site at:

http://scansnap.fujitsu.com/g-support/en/

Operating system (*1) macOS High Sierra v10.13 (*2)
macOS Sierra v10.12.1 or later (*2)
OS X El Capitan v10.11

CPU Intel® Core™ i5 2.5 GHz or higher

Memory 4 GB or more

Display resolution 1024 × 768 pixels or higher

Disk space Free space required to install the software related to the ScanSnap is as follows:
(*3)
l ScanSnap Manager: 640 MB
l ScanSnap Organizer: 95 MB
l CardMinder: 600 MB
l ABBYY FineReader for ScanSnap: 980 MB
l ScanSnap Online Update: 20 MB
l OCR Pack (*4)
l ScanSnap S1100i Basic Operation Guide: 100 MB

USB port USB 3.0 (*5)/USB 2.0/USB 1.1

*1: Updating Mac OS to the latest version is recommended.

*2: ABBYY FineReader for ScanSnap 5.0 is not supported.

*3: To save scanned images, more free space is required.

For details about estimated image data size, refer to the ScanSnap Manager Help.

*4: By installing the OCR Pack, you can add extra languages to recognize text.

For the amount of free space required to install the OCR Pack, refer to the following:

http://www.fujitsu.com/global/support/products/computing/peripheral/scanners/scansnap/
software/ocrpack-setup.html

*5: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.

ATTENTION
l If the system requirements above are not satisfied, the ScanSnap may not operate.
l If a USB port on the keyboard or on the monitor is in use, the ScanSnap may not operate.
l When using a commercially available USB hub, use a type that is powered from an electrical power

supply (and that comes with an adapter).
l Scanning speed decreases in the following cases:

- The CPU or the memory does not meet the recommended specifications.
- The version of the USB port or the USB hub is USB 1.1.

l To scan a document, a disk space that is approximately three times larger than the size of the file
to be saved is required.

System Requirements
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Overview of the Software Related to the ScanSnap

This section gives an overview of each bundled software and their functions. You can edit, manage,
and arrange the scanned image by using the following software:

ScanSnap Manager
This scanner driver is required to scan documents with the ScanSnap. Scanned images can be
saved as PDF or JPEG files to a computer.

You need to have ScanSnap Connect Application installed on your mobile device to save PDF or
JPEG files to your mobile device.

You can download ScanSnap Connect Application for your mobile device from its application
market.

ScanSnap Organizer
You can use this application to display image data (PDF or JPEG files) in a list, create folders, and
arrange files as you like.

CardMinder
You can use this application to efficiently digitalize a large number of business cards.

Text recognition can be performed on business cards and you can create a database to facilitate
card data management and searches. Data in the database can be printed and linked with various
applications. The data can be also shared with PIM (Personal Information Manager), such as
Contacts.

ABBYY FineReader for ScanSnap
This application can perform text recognition on the scanned images using OCR (Optical
Character Recognition) to convert the image data to Word, Excel, or PowerPoint files that can be
edited.

ScanSnap Online Update
This application checks whether the latest updates or software programs are available on the
download server. When the latest updates or software programs are available, you can
automatically apply updates or download and install the software programs manually.

Evernote for Mac
You can easily save files in Evernote using the ScanSnap.

Dropbox for Mac
You can easily save files to your Dropbox folder using the ScanSnap.

Overview of the Software Related to the ScanSnap
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How to Install the Software

When you insert the Setup DVD-ROM into the DVD-ROM drive on your computer, the [ScanSnap]
window appears.

ATTENTION
l Do not connect the ScanSnap to the computer before installing the software. Doing so may cause

the ScanSnap not to be recognized by the computer. In that case, install the software, and then
reconnect the ScanSnap to the computer.

l If a DVD-ROM drive is not available, the installers for the software programs can be downloaded
from the following web page.
http://scansnap.fujitsu.com/g-support/en/

The functions of each button in the [ScanSnap] window are as follows.

Icon Function

ScanSnap Starts installing software.

Other Software Displays the [Other Software] window. From this window, you can access the
download web pages of the software programs.

Readme Displays the Readme file.

Manuals The [Manuals] window appears. You can refer to Safety Precautions, Getting Started,
the Basic Operation Guide (this manual), and the Advanced Operation Guide.

How to Install the Software

37

http://scansnap.fujitsu.com/g-support/en/


ScanSnap Manager Icon

When ScanSnap Manager is running, the ScanSnap Manager icon is displayed in the Dock.

The ScanSnap Manager icon indicates whether or not ScanSnap Manager is successfully
communicating with the ScanSnap. The appearance of the icon changes according to the
communication status as shown below.

Communication Status ScanSnap Manager Icon

Communicating

Not communicating

HINT
Turn the ScanSnap on to begin communication between ScanSnap Manager and the ScanSnap. For
details about how to turn on the ScanSnap, refer to "Turning the ScanSnap On" (page 43).

You can display the menu for scanning documents and ScanSnap Manager settings from the
ScanSnap Manager icon.

l Clicking while holding down the [control] key on the keyboard

Displays the "ScanSnap Manager Menu" (page 39).

l Clicking

Displays the Profile menu.

For details, refer to the Advanced Operation Guide.

ScanSnap Manager Icon
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ScanSnap Manager Menu

This menu appears when you click the ScanSnap Manager icon  in the Dock while holding
down the [control] key on the keyboard.

Click While Pressing the [control] Key
on the Keyboard

Item Function

Scan Scans the document inserted in the ScanSnap. Follows the settings configured in
[Settings].

Settings Displays the "ScanSnap Setup Window" (page 41). You can configure the scan
settings in this window.

Profile Displays the Profile menu.
You cannot select this when the [Use Quick Menu] checkbox is selected in the
ScanSnap setup window.

Profile Management Displays the [ScanSnap Manager - Profile Management] window.
You cannot select [Profile Management] when the [Use Quick Menu] checkbox is
selected in the ScanSnap setup window.
For details, refer to the Advanced Operation Guide.

Connect by Wi-Fi Displays the [ScanSnap Manager - Connect by Wi-Fi] window.
Available with iX500 and iX100.

Preferences Displays the [ScanSnap Manager - Preferences] window.

ScanSnap Manager Menu
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Item Function

Help Displays the following menu:
l Help

Opens the ScanSnap Manager Help.
l Troubleshooting

Displays [Troubleshooting] in the ScanSnap Manager Help.
l ScanSnap Portal Site

Opens the ScanSnap global homepage (http://scansnap.fujitsu.com).
l About ScanSnap Manager

Displays the [ScanSnap Manager - Version Information] window.
l ScanSnap information

Displays the [ScanSnap Manager - Scanner and driver information] window.
Displayed when the ScanSnap and computer are connected.

l Online Update
Starts the ScanSnap Online Update.
For details, refer to the Advanced Operation Guide.

To establish connection Displayed when ScanSnap Manager is not communicating with the ScanSnap
correctly.

Options Displays the following menu:
l Keep in Dock

Adds the ScanSnap Manager icon  to the Dock.
l Open at Login

Automatically launches ScanSnap Manager when the computer is started up or
logged in.

l Show in Finder
Displays the contents of the [ScanSnap] folder by using the Finder.

Show All Windows Shows all windows from ScanSnap Manager in thumbnails.

Hide/Show Hides or shows all windows from ScanSnap Manager.

Quit Quits ScanSnap Manager.

ScanSnap Manager Menu
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ScanSnap Setup Window

When you click the ScanSnap Manager icon  while holding down the [control] key on the
keyboard, and then select [Settings] from the "ScanSnap Manager Menu" (page 39), the following
ScanSnap setup window appears.

In the ScanSnap setup window, you can use the [Use Quick Menu] checkbox to specify whether or
not to use the Quick Menu. You can also use the profile buttons and detail setting tabs to specify
scan settings according to your scanning needs.

For details, refer to the ScanSnap Manager Help.

Profile Buttons

Detail Setting Tabs

ScanSnap Setup Window

41



Turning the ScanSnap On or Off

This section explains how to turn the ScanSnap on or off.

l "Turning the ScanSnap On" (page 43)

l "Turning the ScanSnap Off" (page 45)

l "Sleep Mode" (page 46)

Turning the ScanSnap On or Off

42



Turning the ScanSnap On

1. Turn on the computer.

a The computer starts up and the ScanSnap Manager icon  appears in the Dock.

HINT

l If the ScanSnap Manager icon  is not displayed in the Dock, click [Applications] from the
sidebar in Finder, click [ScanSnap], and then double-click [ScanSnap Manager].

l If ScanSnap Manager does not automatically start when you log in to the computer, display
the [System Preferences] window and select [Users & Groups] → [Current User] → [Login

Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

2. Open the feed guide of the ScanSnap to turn the power on.

a The [Scan/Stop] button flashes in blue. The button returns to being lit normally when
document scanning is enabled.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
With some computers, the initialization of the ScanSnap may be performed several times when
the computer is started up.

HINT

l It may take more time for the ScanSnap Manager icon in the Dock to change to 
depending on computer performance, operating environment, or loading, for example, when
many software programs are running at the same time.

l When the ScanSnap is turned on, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

Turning the ScanSnap On or Off
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1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 39).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Turning the ScanSnap Off

1. Close the feed guide.

a The [Scan/Stop] button turns off.

In addition, the ScanSnap Manager icon in the Dock changes from  to .

ATTENTION
If moving the ScanSnap, first turn the power off and remove all cables.

HINT
l The power of the ScanSnap is linked with the power of the computer to which the ScanSnap

is connected. If you keep the ScanSnap connected to the computer, you do not have to worry
about turning the power ON/OFF.

l With some computers, it may take 2 to 3 minutes until the light of the [Scan] button goes out
after the computer is turned off.

l When the ScanSnap is turned off, a notification window notifies you of the ScanSnap's
communication status.
To disable notifications of the ScanSnap's communication status, change the setting in the
following procedure:

1. Click the ScanSnap Manager icon  in the Dock while holding down the [control] key
on the keyboard, and then select [Preferences] from the "ScanSnap Manager Menu"
(page 39).
a The [ScanSnap Manager - Preferences] window appears.

2. Clear the [Notify of the communication status] checkbox in the [Status Display] list.

Turning the ScanSnap On or Off
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Sleep Mode

When the ScanSnap is on and has not been used for one minute, it enters sleep (power saving)
mode.

Turning the ScanSnap On or Off
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Documents to Scan

This section explains about the conditions for documents that can be loaded directly into the
ScanSnap and the conditions for documents that can be scanned using the Carrier Sheet.

l "Documents That Can Be Loaded Directly into the ScanSnap" (page 48)

l "Documents That Can Be Scanned Using the Carrier Sheet" (page 50)

Documents to Scan
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Documents That Can Be Loaded Directly into the ScanSnap

Conditions for documents that can be loaded directly into the ScanSnap are as follows:

Eject method
(*1)

With the output guide closed With the output guide open

Document type Office paper, postcards, business cards
Plastic cards conforming to the ISO7810 ID-1
type (54 × 86 mm/3.37 × 2.13 in.) (*2)

Office paper

Paper weight 52.3 to 209.3 g/m2 (14 to 56.1 lb)

When merging scanned images
automatically (*3)

52.3 to 104.7 g/m2 (14 to 28 lb)

Plastic cards
0.76 mm (0.03 in.) or less (embossed cards
can be used)

52.3 to 80 g/m2 (14 to 20 lb)

Paper size Width
25.4 to 216 mm (1 to 8.5 in.)
For a dual scan, a total width of 200 mm (7.87 in.) or less for two documents

Length
25.4 to 863 mm (1 to 34 in.)

When merging scanned images automatically (*3)
l A3 (297 × 420 mm)
l B4 (257 × 364 mm)
l Double Letter (11 × 17 in. (279.4 × 432 mm))

*1: For details about the eject methods, refer to "Parts and Functions" (page 33).

*2: A dual scan cannot be used for plastic cards.

*3: Fold in half to scan.

ATTENTION
l The following types of documents must not be scanned:

- Documents attached with the metals such as paper clips or staples that can damage the inside
of the ScanSnap
Remove the metals for scanning.

- Documents on which the ink is still wet
Wait until the ink dries completely to scan these documents.

- Documents larger than 216 × 863 (mm)/8.5 × 34 (in.) (width × length)
- Documents other than paper such as fabric, metal foil and OHP film

l When you scan picture postcards, be aware that the picture side may get damaged. It is the
responsibility of the customer to scan picture postcards.

l Be careful of the following when you scan plastic cards:
- Cards that are bent may not be fed properly.
- If the surface of the card is dirty with grease marks such as fingerprints, perform scanning after

wiping the dirt off.

Documents to Scan
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- Insert the plastic card straight into the feeding section of the ScanSnap. Do not tilt the plastic
card when you insert it because the plastic card may not be fed properly.

- When you scan plastic cards with strong luster, some parts of the image may appear lighter or
darker than the original.

Example: gold colored credit card
- When you scan an embossed card, insert it in the direction shown below.

1 2 3 4 5 6 7 8 9 0
ABCDEFG

1234567890
ABCDEFG

- If the embossed characters are not coated in gold or silver and the background color of the card
and the color of the embossed characters are similar, it may be difficult for the ScanSnap to
recognize embossed characters.
In which case, performing the following may result in an improvement.
1. Click the [Option] button in the [Scanning] tab of the "ScanSnap Setup Window" (page 41).

a The [Scanning mode option] window appears.

2. Select the [Increase text contrast] checkbox.

Documents to Scan
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Documents That Can Be Scanned Using the Carrier Sheet

The optional Carrier Sheet is a sheet designed to transport documents through the ScanSnap.

You can scan documents that are larger than A4/Letter size, photographs, and clippings.

Conditions for documents that can be scanned using the Carrier Sheet are as follows:

�������
l Do not use a damaged Carrier Sheet. Otherwise, it may damage or cause

the ScanSnap to malfunction.

l Be careful not to cut your finger on the edge of the Carrier Sheet.
 

Eject method With the output guide closed

Document type Documents that cannot be loaded directly into the ScanSnap

Paper weight Up to 52.3 to 104.7 g/m2 (14 to 28 lb)

When scanning documents folded in half:
Up to 64 g/m2 (17 lb)

Paper size Carrier Sheet size (216 × 297 mm)
A3 (297 × 420 mm) (*1)
A4 (210 × 297 mm)
A5 (148 × 210 mm)
A6 (105 × 148 mm)
B4 (257 × 364 mm) (*1)
B5 (182 × 257 mm)
B6 (128 × 182 mm)
Postcard (100 × 148 mm)
Business card (90 × 55 mm, 55 × 90 mm)
Letter (8.5 × 11 in. (216 × 279.4 mm))
11 × 17 in. (279.4 × 431.8 mm) (*1)

Custom size
Width: 25.4 to 216 mm (1 to 8.5 in.)
Length: 25.4 to 297 mm (1 to 11.69 in.)

*1: Fold in half to scan.

Documents for Which the Carrier Sheet is Recommended for
Scanning
It is recommended that you use the Carrier Sheet to scan the following documents.

l Documents written in pencil

Because there may be black traces left on the documents, it is recommended that you use the
Carrier Sheet to scan such documents.

When you scan such documents directly without using a Carrier Sheet, dirt will accumulate on
the rollers, which may cause feeding errors. Clean the rollers occasionally.

For details about how to perform cleaning, refer to "Cleaning the Inside of the ScanSnap" (page
93).

l Carbonless paper

Documents to Scan
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Because carbonless paper may contain chemicals that can harm the ScanSnap internal rollers, it
is recommended that you use the Carrier Sheet to scan such documents.

Make sure to clean the rollers occasionally to maintain the scanner performance when scanning
carbonless paper directly without using the Carrier Sheet. For details about how to perform
cleaning, refer to "Cleaning the Inside of the ScanSnap" (page 93).

Depending on the type of carbonless paper, the life span of the scanner may be shortened
compared to scanning office paper.

l Scanning the following types of documents without using the Carrier Sheet can result in
documents being damaged or scanned incorrectly

- Documents smaller than 25.4 × 25.4 (mm)/1 × 1 (in.) (width × length)

- Documents whose paper weight is less than 52.3 g/m2 (14 lb)

- Documents with an uneven surface (such as envelopes and paper sheets with attached
materials)

- Wrinkled or curled documents

- Folded or torn documents

- Tracing paper

- Coated paper

- Photographs (photographic paper)

- Perforated or punched documents

- Documents that are not rectangular or square

- Carbon paper or thermal paper

- Documents with memo papers or sticky notes attached

ATTENTION
l Using the Carrier Sheet

Be careful of the following when you use the Carrier Sheet:
- Do not stain, or cut the end with a black & white pattern. Otherwise, the Carrier Sheet will not be

recognized properly.
- Do not place the Carrier Sheet upside down. Otherwise, a paper jam may occur and damage

the Carrier Sheet and the document inside.
- Do not fold or pull the Carrier Sheet.
- Paper jams may occur when several small size documents such as photographs and postcards

are placed inside the Carrier Sheet to be scanned at once. It is recommended that you scan
such documents one at a time.

l Storing the Carrier Sheet
Be careful of the following when you store the Carrier Sheet:
- Do not leave your document inside the Carrier Sheet for a long time. Otherwise, the ink on the

document may be transferred onto the Carrier Sheet.
- Do not leave the Carrier Sheet in high temperature places such as under direct sunlight or near

a heating apparatus for a long time. Also, do not use the Carrier Sheet in high temperature
places. The Carrier Sheet may be deformed.

- To avoid deformation, store the Carrier Sheet on a flat surface without any weight on it.
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What You Can Do with Related Software

This section explains the basic operation procedure of software related to the ScanSnap and gives
an overview of its functions.

l "What You Can Do with the ScanSnap Organizer" (page 53)

l "What You Can Do with CardMinder" (page 58)

What You Can Do with Related Software

52



What You Can Do with the ScanSnap Organizer

ScanSnap Organizer is an application used for displaying, organizing, and managing image data
(PDF or JPEG files) scanned with the ScanSnap.

You can use this application to create folders and arrange files for various uses.

Pages of a PDF file can be opened with an associated application to check the scanned image data.

Main Window

Scan documents with the ScanSnap

l "Basic Operation Procedure of ScanSnap Organizer" (page 54)

l "Managing Files" (page 55)

l "Using Files" (page 57)
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Basic Operation Procedure of ScanSnap Organizer

This section explains the basic operation procedure of ScanSnap Organizer.

1. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and then double-click [ScanSnap Organizer] to start up ScanSnap Organizer.

2. Scan documents with the ScanSnap.
a A list of scanned images is displayed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Managing Files

For details about operations, refer to the ScanSnap Organizer Help.

Setting a Marked Character String as a Keyword
Keywords can be set to a PDF file by using the keyword setting function.

These keywords can be used when you search for PDF files.

When black and white documents that have been marked are scanned by the ScanSnap, the
marked character strings are set as keywords for the PDF file.

Mark the characters 
on a document

"Proposal" can be used as a keyword 
to search for the file

Document PDF file with a keyword

Proposal

Proposal

Scan the document 
with the ScanSnap

Recognizing a Character String in a Page to Embed It into the Page
By using text recognition (OCR) software, you can embed character strings into the page of a PDF
file scanned by the ScanSnap, and then search the PDF file using the character strings.

OCR recognizes "proposal" 
as textual information.

PDF file

"Proposal" can be used 
as a keyword 
to search for the fileProposal

What You Can Do with the ScanSnap Organizer
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Searching Files
You can search files that are managed in ScanSnap Organizer.

What You Can Do with the ScanSnap Organizer
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Using Files

For details about operations, refer to the ScanSnap Organizer Help.

Linking Files with Other Applications
You can use files with a variety of applications.

Sending Files by E-mail
Files can be sent by e-mail.

Using Files by Syncing with a Mobile Device
By using the ScanSnap Sync function, an image file scanned by the ScanSnap can be synced
automatically with a mobile device and can be used easily anytime or anywhere via a cloud service.

The files are organized and managed in the "ScanSnap Sync" folder in ScanSnap Organizer.

Syncing Files Made up of Images That Were Saved Together ("JPEG
(Save together)" Files)
Using the ScanSnap Sync function allows you to sync "JPEG (Save together)" files between a
mobile device and ScanSnap Organizer.

A "JPEG (Save together)" file consists of multiple images that are scanned with ScanSnap Connect
Application.

What You Can Do with the ScanSnap Organizer
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What You Can Do with CardMinder

CardMinder is an application used for displaying, organizing, and managing card image data
scanned with the ScanSnap.

This application digitalizes large amounts of business cards into images at a high speed and
recognizes text on those cards, thus allowing you to search for your clients' business cards from
those data quickly, and create your client databases conveniently. CardMinder uses an Optical
Character Recognition (OCR) engine to recognize text on cards and shares the data with Personal
Information Manager (PIM) applications.

CardMinder also enables business card data to be quickly searched from other applications.

Card

CardMinder window

Scan using ScanSnap

Recognized data

Share the recognized data with PIM
(Example: Contacts)

l "Basic Operation Procedure of CardMinder" (page 60)

l "Linking Card Data with Other Applications" (page 63)

l "Searching Card Data with the Basic Search Toolbar" (page 64)

l "Searching Card Data with Keyboard Shortcuts" (page 65)
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l "Attaching a File to Card Data" (page 66)

What You Can Do with CardMinder

59



Basic Operation Procedure of CardMinder

This section explains the basic operation procedure of CardMinder.

1. Start CardMinder.
From the sidebar in Finder, select [Applications] → [CardMinder], and then double-click
[CardMinder].

2. Scan a card with the ScanSnap.
Load a card in the ScanSnap and press the [Scan] button to start scanning the card.

When scanning is complete, the information printed on the card (such as name, company, and
address) is automatically recognized as text and displayed in the Card Data Edit view.

The image data scanned from the card is displayed in the Card Image view.

ATTENTION
ScanSnap Manager must be installed on your computer when you want to recognize the
following languages:
l Chinese (simplified)
l Chinese (traditional)
l Korean

3. Check the card data.
Make sure that the front and back card images are correct, and that the text on the card
images are displayed correctly in the Card Data Edit view.
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Card Data Edit ViewCard Image View

4. If the language to be used for text recognition is different, perform text
recognition again in the following procedure:
1. Select [CardMinder] menu → [Preferences].

a The [General] window appears.

2. Select a language for the character strings to be recognized from [Recognition Language].

a The recognition language changes.

3. Close the [General] window.

4. Click the [Recognize] button on the Toolbar again.

a Character strings on the card data will be recognized as the selected language.
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5. Correct the card data, if necessary.
The card data can be corrected in the following ways. For details, refer to the CardMinder
Help.

l Redoing the recognition process on the character strings in the selected areas

l Entering text directly in the Card Data Edit view

l Correcting the orientation of the card image or switching the front and back images

3 41 2

No. Description

1 Using the [Rotate] button, you can rotate the card image.

2 Using the [Modify Image] button, you can switch the front and back images of the card image, create
double-sided cards, and delete the back image.

3 By selecting character strings in the card image and then clicking the buttons of the appropriate fields in
the Card Data Edit view, you can redo the recognition process on the selected areas.

4 You can directly correct the text of each field in the Card Data Edit view.

6. Exit CardMinder.
Click [CardMinder] menu → [Quit CardMinder] to quit CardMinder.
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Linking Card Data with Other Applications

Click the following buttons on the Toolbar to use card data in a variety of applications.

The following explains an example in which the Toolbar is customized to display the [Application]
button.

1 2 3 4

No. Item Description

1 E-mail You can start an e-mail program, using the e-mail address specified in [E-mail] for
the card data as the destination address.

2 Internet search You can search the URL specified in [Website] for the card data with a web browser.

3 Outputting card data in
a different format

You can output card data in the vCard, CSV, text, or ContactXML format.

4 Linking card data with
another application

You can link card data with another application such as Outlook or Salesforce CRM
to use the card data in the linked application. You can also link card data with USB
media to use the card data on a different computer.

For details, refer to CardMinder Help.
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Searching Card Data with the Basic Search Toolbar

This section explains how to search card data with the CardMinder Basic Search Toolbar.

Find (Basic Search Toolbar)

To search card data, type in a search term (such as an individual name or a company name) in the
Basic Search Toolbar.

The search results are displayed in the Card Data List view.
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Searching Card Data with Keyboard Shortcuts

Even when CardMinder is not running, you can search card data by using a character string in
another application (such as TextEdit) as the keyword for searching.

1. Drag the mouse to select a character string you want to search for.

2. Press [command ] + [shift] + [&] keys on the keyboard at the same time.
a While the Card Data Edit view is hidden, CardMinder starts and search is executed.

Card data matching the search conditions is displayed in the Card Data List view.

HINT
l Depending on the keyboard type, you may not have to press the [shift] key.
l If the keyboard shortcuts do not work, check the [Search Selected Text in CardMinder] shortcut key

by selecting [System Preferences] → [Keyboard] → [Services] in the [Keyboard Shortcuts] tab, and
change the shortcut key to the one to be used.
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Attaching a File to Card Data

A file can be attached to card data easily by dragging and dropping it.
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Useful Usages

This section explains how to use related software for the scanned image that is created after a
document is scanned with the ScanSnap and how to scan a document with a setting other than the
default setting.

l "Managing Paper Documents by Folder on a Computer" (page 68)

l "Saving Business Cards to a Computer" (page 71)

l "Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)" (page 74)

l "Scanning Documents Such as Photographs and Clippings" (page 79)

Useful Usages
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Managing Paper Documents by Folder on a Computer

This section explains how to digitize paper documents and manage the data by folder in ScanSnap
Organizer.

1. Scan a paper document with the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 17).

a The Quick Menu appears.

2. Click the [ScanSnap Organizer] icon  in the Quick Menu.
a The [ScanSnap Organizer] window appears.
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3. From the menu bar, select [File] → [New Folder].
a A new folder is created in the folder list.

4. Rename the created folder.

HINT
To create multiple folders, repeat steps 3 to 4.

5. Select the scanned image from the file list, and drag and drop it to the folder.

Managing Paper Documents by Folder on a Computer
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a The scanned image is moved to the folder.

HINT
For details about other functions, refer to the ScanSnap Organizer Help.
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Saving Business Cards to a Computer

This section explains how to digitize business cards and save the card data in CardMinder.

ATTENTION
If you do not log in as a user with Administrator privileges, you may not be able to link the ScanSnap
with another application properly.

1. Scan business cards with the ScanSnap.
For details about scanning business cards, refer to the following.

l "Scanning a Document" (page 17)

l "Scanning Documents with the ScanSnap by Inserting Two Documents at a Time or by
Inserting the Next Document While the Current Document Is Being Scanned" (page 22)

a The Quick Menu appears.

2. Click the [CardMinder] icon  in the Quick Menu.
a The [CardMinder] window appears.
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3. Check the card data.
Make sure that the text on the card images are displayed correctly in the Card Data Edit view.

If the card data must be corrected, click the text to be corrected and then directly edit it.

Card Data Edit ViewCard Image View
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HINT
When you scan double-sided business cards, you must scan one side of each card and edit the card
data in CardMinder.
For details, refer to the CardMinder Help.
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Scanning Documents Larger Than A4 or Letter Size
(with the Carrier Sheet)

Documents larger than A4/Letter size (such as A3, 11 × 17 in. and B4) can be scanned with the
optional Carrier Sheet. By folding the document in half and scanning both sides, one at a time, the
two sides are merged into a single image.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using
the Carrier Sheet" (page 50).

ATTENTION
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled.
To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the
"ScanSnap Setup Window" (page 41).

HINT
Both sides of a double-sided A4/Letter size document or smaller can also be scanned and merged into
a single image.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 39).
a The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click
the [Carrier Sheet Settings] button.

a The [Carrier Sheet Settings] window appears.
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3. Select [one double-page spread image] in [Save as] and click the [OK]
button.
For details, refer to the ScanSnap Manager Help.

4. Click the [Apply] button in the ScanSnap setup window.

5. Click  at the upper left of the window to close the ScanSnap setup window.

6. Place the document inside the Carrier Sheet.
1. Fold the document in half with the sides to be scanned facing out.

Fold it tightly and smooth out any creases.

2. Open the Carrier Sheet to bind the document.

Align the fold line with the right edge of the Carrier Sheet so that the document fits in the
upper right-hand corner of the Carrier Sheet.
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HINT
Note that the front side of the Carrier Sheet has a black and white pattern at the top and a
thick vertical line in the upper right-hand corner.

7. Insert the part with the black and white pattern straight into the feeding
section of the ScanSnap, with the front side of the Carrier Sheet facing up.

a The Carrier Sheet is pulled in until it is set inside the ScanSnap.

HINT
If you perform a scan using the Carrier Sheet with the output guide open, a paper jam may occur
and damage the documents. Make sure to close the output guide when you perform a scan using
the Carrier Sheet.

Output Guide

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.
a Scanning starts and the [ScanSnap Manager - Image scanning and file saving] window

appears. When the front side of the Carrier Sheet is scanned, the scanned image is
displayed in the preview area.

Scanning Documents Larger Than A4 or Letter Size (with the Carrier Sheet)

76



9. Turn over the Carrier Sheet and insert it as described in step 7.

ATTENTION
Make sure to scan the front and back side of the Carrier Sheet consecutively.

a Scanning starts automatically and the [ScanSnap Manager - Image scanning and file
saving] window appears. When scanning is completed, scanned images of the front and
back side of the document inside the Carrier Sheet are displayed as a double-page spread
image in the preview area.

HINT
Repeat steps 6 to 9 to scan more documents larger than A4/Letter size. You can continue to
scan documents that can be inserted directly in the ScanSnap.
For details about scanning a document, refer to "Scanning a Document" (page 17).
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10. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
a The scanned images of the front and back sides of the document are saved as a double-

page spread image.

ATTENTION
l There may be a line or a gap appearing between the front and back side images. Also when you

scan a thick document in the Carrier Sheet, the scanned image on the left and the scanned image
on the right of a double-page spread image may skew towards each other from the top.
These symptoms may be improved when you place the document in the Carrier Sheet as follows:
- Fold the document properly
- Neatly align the edges of the document with the edges of the Carrier Sheet
- Turn over the Carrier Sheet to the other (reverse) side

l If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an
optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.)
in [Paper size]. Note that the size of the image may become smaller than the original document
depending on the document.

Example: When characters and illustrations are printed to fit in A4 size in the center of an A3
size document, the scanned image is output in B4 size.

To output the scanned image in its original size, specify the document size in [Paper size].
l Part of the scanned image around where the document is folded may appear missing. In that case,

place the document so that its edge is about 1 mm (0.04 in.) inside from the edge of the Carrier
Sheet.
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Scanning Documents Such as Photographs and
Clippings

Using the optional Carrier Sheet allows you to scan documents that can be damaged quite easily
such as photographs, or non-standard size documents that are difficult to load directly such as
clippings.

For details about documents that can be loaded, refer to "Documents That Can Be Scanned Using
the Carrier Sheet" (page 50).

ATTENTION
The [Deskew by text on document] checkbox in the [Scanning mode option] window will be disabled.
To open the [Scanning mode option] window, click the [Option] button in the [Scanning] tab of the
"ScanSnap Setup Window" (page 41).

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and then select [Settings] from the "ScanSnap
Manager Menu" (page 39).
a The ScanSnap setup window appears.

2. In the [Paper] tab, select [Automatic detection] in [Paper size], and then click
the [Carrier Sheet Settings] button.

a The [Carrier Sheet Settings] window appears.

3. Select [two separate images (front and back)] in [Save as] and click the [OK]
button.
For details, refer to the ScanSnap Manager Help.
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4. Click the [Apply] button in the ScanSnap setup window.

5. Click  at the upper left of the window to close the ScanSnap setup window.

6. Place the document inside the Carrier Sheet.
Open the Carrier Sheet and place the top of the document against the top center of the Carrier
Sheet.

7. Insert the part with the black and white pattern straight into the feeding
section of the ScanSnap, with the scanning side of the document inside the
Carrier Sheet facing up.
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a The Carrier Sheet is pulled in until it is set inside the ScanSnap.

ATTENTION
If you perform a scan using the Carrier Sheet with the output guide open, a paper jam may occur
and damage the documents. Make sure to close the output guide when you perform a scan using
the Carrier Sheet.

Output Guide

8. Press the [Scan/Stop] button on the ScanSnap to start scanning.
a When scanning is complete, the scanned image of the document that is inside the Carrier

Sheet is displayed in the preview area.

HINT
Repeat steps 6 to 8 to scan more documents such as photographs and clippings.
You can continue to scan documents that can be inserted directly in the ScanSnap.
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For details about scanning a document, refer to "Scanning a Document" (page 17).

9. Press the [Scan/Stop] button on the ScanSnap to finish scanning.
a The scanned image is saved.

ATTENTION
l The scanned image is output at the center of the page in the size specified for [Paper size] in the

[Carrier Sheet Settings] window.
l If [Automatic detection] is specified for [Paper size] in the [Carrier Sheet Settings] window, an

optimal size will be selected automatically from the available standard sizes (A3, B4, or 11 × 17 in.)
in [Paper size]. Note that the size of the image may become smaller than the original document
depending on the document scanned, or part of the image may appear missing.

Example: When the contents are printed to fit in A5 size in the center of an A4 size document,
the scanned image is output in A5 size.

To output the scanned image in its original size, specify the document size in [Paper size].

HINT
In the following cases, place a blank (white) sheet of paper underneath the document when scanning:
l The scanned image is not saved in the correct size (when [Automatic detection] is selected for

[Paper size] in the [Carrier Sheet Settings] window)
l Shadows appear around the edges of the scanned image
l Black lines appear around the edges of a uniquely shaped cutting
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Troubleshooting

This section explains how to solve troubles you may encounter upon installing the software related
to the ScanSnap.

l "If You Have Installed the Software Before" (page 84)

l "When the ScanSnap Manager Icon Does Not Appear" (page 85)

l "When ScanSnap Manager Does Not Operate Normally" (page 87)

For details about the troubles you may encounter and the solutions while using the ScanSnap, refer
to the following:

l "Troubleshooting" in the ScanSnap Manager Help

To display this section, click the ScanSnap Manager icon  in the Dock while holding down
the [control] key on the keyboard, and select [Help] → [Troubleshooting] from the "ScanSnap
Manager Menu" (page 39).

l ScanSnap Support Site (http://scansnap.fujitsu.com/g-support/en/)

If you cannot solve the problem after referring to the above section, contact your FUJITSU scanner
dealer or an authorized FUJITSU scanner service provider.
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If You Have Installed the Software Before

If your attempt to reinstall the software related to the ScanSnap (including models other than S1100i)
failed, uninstall the software and then reinstall it.

For details, refer to the following:

l "Uninstalling the Software" (page 99)

l "How to Install the Software" (page 37)
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When the ScanSnap Manager Icon Does Not Appear

This section explains how to troubleshoot when the ScanSnap Manager icon  does not appear
in the Dock even though the software is installed and the ScanSnap is connected to the computer.

l "Displaying the ScanSnap Manager Icon" (page 86)

When the ScanSnap Manager Icon Does Not Appear
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Displaying the ScanSnap Manager Icon

1. From the sidebar in Finder, select [Applications] → [ScanSnap], and then
double-click [ScanSnap Manager] to start ScanSnap Manager.

HINT
If the problem is solved, you can change the setting so that ScanSnap Manager will start up
automatically from the next time you log in to the computer.
The procedure is as follows.

l On the [System Preferences] window displayed from the Apple ( ) menu, select [Users &

Groups] → [Current User] → [Login Items] → [ ] → [ScanSnap] → [ScanSnap Manager].

l Click the ScanSnap Manager icon  in the Dock while holding down the [control] key on
the keyboard, and then select [Options] → [Open at Login] from the displayed menu.

If the problem persists, refer to "When ScanSnap Manager Does Not Operate Normally" (page 87).
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When ScanSnap Manager Does Not Operate
Normally

If the ScanSnap Manager icon in the Dock is displayed as  even though the software is
installed and the ScanSnap is connected to the computer, perform the following procedures.

l "Checking the Connection between the ScanSnap and the Computer" (page 88)

l "Checking If ScanSnap Manager Is Operating Normally" (page 89)
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Checking the Connection between the ScanSnap and the
Computer

1. Unplug the USB cable from the computer and the ScanSnap, then plug it
back in.
Make sure to leave at least 5 seconds between unplugging and plugging the cable.

If you are using a USB hub, connect the USB cable to the computer directly.

If the problem persists, refer to "Checking If ScanSnap Manager Is Operating Normally" (page 89).
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Checking If ScanSnap Manager Is Operating Normally

1. Turn off the ScanSnap and then turn it on again.
Make sure to leave at least 5 seconds between turning off and on the ScanSnap.

If the problem persists, proceed to step 2.

2. If you are using a USB hub, connect the ScanSnap to the computer directly
with a USB cable.

If the problem persists, proceed to step 3.

3. Turn off the ScanSnap and restart the computer.

If the problem persists, refer to "If You Have Installed the Software Before" (page 84). If the problem still persists,
perform the procedures described in "When ScanSnap Manager Does Not Operate Normally" (page 87) once
again.
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Cleaning

This section explains about the cleaning materials and how to clean the ScanSnap.

l "Cleaning Materials" (page 91)

l "Cleaning the Outside of the ScanSnap" (page 92)

l "Cleaning the Inside of the ScanSnap" (page 93)

l "Cleaning the Carrier Sheet" (page 96)
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Cleaning Materials

Cleaning materials and their part numbers are as below.

Product Name Part No. Unit Note

Cleaner F1 PA03950-0352 1 bottle Size: 100 ml

Cleaning Paper (*1) CA99501-0012 1 pack 10 sheets

Cleaning Wipe (*2) PA03950-0419 1 pack 24 packets

Lint-free dry cloth (*3) Commercially
available

- -

*1: Used with Cleaner F1.

*2: The cleaning wipes are wet tissues that have been soaked with Cleaner F1. In place of this
product, you can use a cloth soaked with Cleaner F1.

*3: Any lint-free cloth can be used.

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the cleaning materials.

For details, refer to the following web page:

http://scansnap.fujitsu.com/

Cleaning Materials
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Cleaning the Outside of the ScanSnap

Clean the outside of the ScanSnap in the following procedure.

1. Unplug the cables from the ScanSnap.

2. Clean the outside of the ScanSnap with a dry cloth, or a cloth moistened with
Cleaner F1/mild detergent.

ATTENTION
l Never use paint thinner or any other organic solvents. The shape or color may be changed.
l When cleaning the ScanSnap, prevent liquids from entering the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the

cloth with moderate quantity. Wipe off the cleaner completely with a soft cloth to leave no
residue on the cleaned parts.

Cleaner F1 or 
Mild DetergentCloth
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Cleaning the Inside of the ScanSnap

Scanning repeatedly may cause dust and paper dust to accumulate inside the ScanSnap resulting in
a scanning error.

As a guideline, the inside of the ScanSnap should be cleaned every 100 sheets scanned. Note that
this guideline varies depending on the types of documents you scan. For instance, it may be
necessary to clean the scanner more frequently when you scan documents on which the toner is not
sufficiently fused.

�������
l Before you clean the ScanSnap, you must close the feed guide, turn off the

ScanSnap, and unplug the USB cable. Not doing so may cause fire or
electrical shock.

l Do not use aerosol spray or spray that contains alcohol to clean the
scanner. Paper dust and other dust blown up by strong air from the spray
may enter inside of the scanner which may cause scanner failure or
malfunction.

Also note that sparks generated by static electricity may cause a fire.
 

ATTENTION
l Do not use water or mild detergent to clean the inside of the ScanSnap.
l It may take a long time for Cleaner F1 to dry if an excessive amount is used. Moisten the cloth with

moderate quantity.
Wipe off the cleaner completely to leave no residue on the cleaned parts.

HINT
To check the number of sheets scanned with the ScanSnap, see [Total Page Count] in the [ScanSnap
Manager - Scanner and driver information] window.
To open the [ScanSnap Manager - Scanner and driver information] window, click the ScanSnap

Manager icon  in the Dock while holding down the [control] key on the keyboard, and click [Help]
→ [ScanSnap information] from the "ScanSnap Manager Menu" (page 39).

1. Clean the glass and idler rollers.
1. Unplug the cables from the ScanSnap.

2. Open the top cover and output guide.
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Feed Guide

Top Cover

Output Guide

3. Clean the following locations with a cloth moistened with Cleaner F1.

Glass (x 2) Idler Roller (x 12)

l Glass (× 2, one on the top cover and one on the opposite side)

Gently wipe the dirt and dust off the surface of the glass sections.

l Idler roller (× 12, located on the top cover)

Gently wipe the dirt and dust off the rollers as you rotate them manually. Be careful not
to damage the surface of the rollers. Make sure that they are cleaned properly because
residue on the rollers will affect the feeding performance.

2. Clean the feed roller and eject roller.
1. Connect the USB cable to the USB connector on the ScanSnap and the USB port on the

computer, and press the [Scan/Stop] button for three seconds with the top cover open.

ATTENTION
Connect the USB cable to the USB port on the computer only when cleaning the feed rollers
and eject rollers.

2. Clean the following locations with a cloth moistened with Cleaner F1.

Eject Roller (x 1)

Feed Roller (x 1)

l Feed roller (× 1)
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Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt and dust off while
taking care not to damage the surface of the roller. Make sure that they are cleaned
properly because residue on the roller will affect the feeding performance.

l Eject roller (× 1)

Press the [Scan/Stop] button to rotate the roller. Gently wipe the dirt and dust off while
taking care not to damage the surface of the roller. Make sure that they are cleaned
properly because residue on the roller will affect the feeding performance.

If eject roller is difficult to clean, try cleaning it from the back while you keep the top
cover slightly open.

Eject Roller (x 1)

HINT
Pressing the [Scan/Stop] button seven times will rotate the feed roller and the eject roller one
revolution.

3. Close the top cover and the output guide.

Top Cover Feed Guide

Output Guide

a It clicks when it returns to its original position.

ATTENTION
Make sure that the top cover is completely closed.
Otherwise, paper jams or other feeding errors, or image faults may occur.
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Cleaning the Carrier Sheet

As you keep using the Carrier Sheet, dirt and dust will accumulate on the surface and the inside.

Clean the Carrier Sheet regularly because it may result in scanning errors.

The procedure for cleaning the Carrier Sheet is as follows.

Cleaning
Gently wipe the dirt and dust off the surface and the inside of the Carrier Sheet with a dry cloth, or a
cloth moistened with Cleaner F1/mild detergent.

ATTENTION
l Do not use paint thinner or any other organic solvents.
l Do not use force to rub. The Carrier Sheet may be damaged or deformed.
l Be careful not to leave any crease on the Carrier Sheet.
l After cleaning the inside of the Carrier Sheet with a cloth moistened with Cleaner F1/mild detergent,

make sure that it is completely dry before closing the Carrier Sheet.
l The Carrier Sheet should be replaced approximately every 500 scans.

Cleaning the Carrier Sheet
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l "Updating the Software" (page 98)
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l "Specifications of the ScanSnap" (page 107)
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Updating the Software

Latest updates for ScanSnap related software are available for free from our download server. This
is called ScanSnap Online Update.

It is recommended that you apply latest updates to enhance security, operability and functions.

For the software programs that can be updated, refer to the following:

http://www.fujitsu.com/global/support/computing/peripheral/scanners/software/online-setup-help.html

ScanSnap Online Update checks the download server periodically.

When the latest version of ScanSnap is available, the update list window appears.

To install the update, follow the instructions on the window.

For details, refer to the ScanSnap Online Update Help.

You can also manually check from ScanSnap Manager whether a newer version of the program is
available and run the update.

1. Click the ScanSnap Manager icon  in the Dock while holding down the
[control] key on the keyboard, and click [Help] → [Online Update] from the
"ScanSnap Manager Menu" (page 39).
a ScanSnap Online Update checks whether a newer version of ScanSnap Manager is

available. Proceed with the update as you follow the instructions.

For details, refer to the ScanSnap Online Update Help.

ATTENTION
l To run the online update for ScanSnap Manager, you need to have access to the Internet.
l Log in as a user with Administrator privileges.

HINT
For details about updates of ScanSnap Manager, visit the following web pages:
http://scansnap.fujitsu.com/g-support/en/
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Uninstalling the Software

This section explains how to uninstall the following software programs:

l "Uninstalling ScanSnap Manager" (page 100)

l "Uninstalling ScanSnap Organizer" (page 102)

l "Uninstalling CardMinder" (page 103)

l "Uninstalling ABBYY FineReader for ScanSnap" (page 104)

l "Uninstalling ScanSnap Online Update" (page 105)
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Uninstalling ScanSnap Manager

Uninstall ScanSnap Manager.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap] → [Sub], and
then double-click [ScanSnap Uninstaller].
a The [ScanSnap Uninstaller] window (the [Welcome to ScanSnap Uninstaller] screen)

appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.

6. Click the [Close] button.

HINT
When a user other than the user who uninstalled ScanSnap Manager has set ScanSnap
Manager as a login item, the following operations are required:
1. Log in as a user who has set ScanSnap Manager as a login item.

2. From the Apple ( ) menu, select [System Preferences].
a The [System Preferences] window appears.

3. Select [Users & Groups].
a The [Users & Groups] window appears.

4. From [Current User], select the currently logged-in user.

5. Select the [Login Items] tab.
a A list of login items appears.

6. From the list of login items, select [ScanSnap Manager].

7. Click the [ ] button under the list of login items.
a [ScanSnap Manager] is deleted from the list of login items.
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8. Close the [Users & Groups] window.
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Uninstalling ScanSnap Organizer

Uninstall ScanSnap Organizer.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ScanSnap Organizer if it is running.

3. From the sidebar in Finder, select [Applications] → [ScanSnap Organizer],
and drag the [ScanSnap Organizer] folder into the Trash.

4. Empty the Trash.
a The [ScanSnap Organizer] folder is deleted.
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Uninstalling CardMinder

Uninstall CardMinder.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit CardMinder if it is running.

3. From the sidebar in Finder, select [Applications] → [CardMinder], and drag
the [CardMinder] folder into the Trash.

4. Empty the Trash.
a The [CardMinder] folder is deleted.

HINT
To delete the database, drag the database file into the Trash.
To access the database file stored in the default location, select [Documents] → [CardMinder] →
[CardMinder DB.cxdb] from the sidebar in Finder.
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Uninstalling ABBYY FineReader for ScanSnap

Uninstall ABBYY FineReader for ScanSnap.

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. Exit ABBYY FineReader for ScanSnap if it is running.

3. From the sidebar in Finder, select [Applications] → [ABBYY FineReader for
ScanSnap], and drag the [ABBYY FineReader for ScanSnap] folder into the
Trash.

4. Empty the Trash.
a The [ABBYY FineReader for ScanSnap] folder is deleted.

Uninstalling the Software

104



Uninstalling ScanSnap Online Update

Uninstall ScanSnap Online Update.

HINT
Before uninstalling ScanSnap Online Update, make sure that none of the following software is
installed.
l ScanSnap Manager
l ScanSnap Organizer
l CardMinder

The procedure is as follows.

1. Turn on the computer and log in as a user with Administrator privileges.

2. From the sidebar in Finder, select [Applications] → [ScanSnap Online
Update] → [Sub], and then double-click [AOUUninstaller].
a The [ScanSnap Online Update Uninstaller] window ([Welcome to ScanSnap Online Update

Uninstaller]) appears.

3. Click the [Continue] button.
a The [Important Information] screen appears.

4. Read [Read Me], and then click the [Uninstall] button.
a The authentication window appears.

5. Enter the user name and password for a user with Administrator privileges,
and click the [OK] button.
a Uninstallation starts. When the uninstallation is complete, [Uninstall Succeeded] screen

appears.
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Specifications of Optional Parts

The product names of optional parts are as follows.

Product Name Note

ScanSnap S1100 Case Useful for carrying the ScanSnap.

USB CABLE

ScanSnap S1100 Feed Guide

ScanSnap S1100i Output Guide

ScanSnap Carrier Sheets 5 sheets

Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
details about purchasing the optional parts.

For details, refer to the following portal site:

http://scansnap.fujitsu.com/
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106

http://scansnap.fujitsu.com/


Specifications of the ScanSnap

The following table summarizes the specifications of the ScanSnap.

Item Specification

Product Name ScanSnap S1100i

Scanning method Manual feed (Continuous Document Feeding (CDF) function
supported), simplex scanning, two selectable paper paths (U-
turn path (*1), straight path (*2))

Scanning color mode Simplex, color/gray/black and white/auto (automatic color, gray,
and B&W detection)

Optical system/image sensor Selfoc lens equal-magnification optics/color CIS × 1

Light source 3 color LED (Red/Green/Blue)

Scanning speed (A4 portrait) Automatic resolution/normal/better/best
7.5 sec/sheet

Excellent
35 sec/sheet

Scan area Refer to "Documents to Scan" (page 47)

Document thickness

Interface USB 2.0/USB 1.1 (connector: USB Mini-B type) (*3)

Input power Voltage 5 V (USB bus power)

Power consumption During operation: 2.5 W or less
During sleep mode: 1.0 W or less

Temperature/humidity
allowable ranges

Temperature During operation: 5 to 35 degrees C/41 to 95 degrees F
During standby: -20 to 60 degrees C/-4 to 140 degrees F
During storage/transportation: -20 to 60 degrees C/-4 to 140
degrees F

Humidity During operation: 20 to 80%
During standby: 8 to 95%
During storage/transportation: 8 to 95%

Outer dimensions (Width × Depth × Height) Min.: 273 × 47.5 × 34 mm/10.75 × 1.87 × 1.34 in. (when the
feed guide and output guide are closed)
Max.: 273 × 77 × 52 mm/10.75 × 3.03 × 2.05 in. (when the feed
guide and output guide are open)

Weight 350 g (approx. 0.77 lb)

Environmental specification Compliant with the International Energy Star Program, and
RoHS Directive

Related Software Scanner driver ScanSnap Manager

File management ScanSnap Organizer

Business card
management

CardMinder

Text recognition ABBYY FineReader for ScanSnap

Update management
and application

ScanSnap Online Update

*1: When the output guide is open.

*2: When the output guide is closed.
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*3: When the ScanSnap is connected to a USB 3.0 port, the port operates as a USB 2.0 port.
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About Customer Support and Maintenance

Customer Support
l ABBYY FineReader for ScanSnap

From the sidebar in Finder, select [Applications] → [ABBYY FineReader for ScanSnap] →
[ABBYY FineReader for ScanSnap] → [Help] → [ABBYY FineReader for ScanSnap Help] →
[Technical Support].

l Evernote

Refer to the following web page:

http://www.evernote.com/about/contact/support/

l Google Drive

Refer to the Google Drive Help Center or the Google Product Forums.

To open them, select [Help] in Google Drive.

l Salesforce

Contact the system administrator of your Salesforce.

l Dropbox

Refer to the following web page:

http://www.dropbox.com/contact

l ScanSnap

For other inquiries on the ScanSnap, refer to the ScanSnap Support Site.

http://scansnap.fujitsu.com/g-support/en/

If your problem cannot be solved after referring to the above web pages, visit the following web
page to check the contact information of a suitable Fujitsu office and contact the Fujitsu office.

http://imagescanner.fujitsu.com/warranty.html

Suppliers of Consumables/Optional Parts
http://scansnap.fujitsu.com/

Maintenance
Contact your FUJITSU scanner dealer or an authorized FUJITSU scanner service provider for
repairs on this product.

For details, refer to the following portal site:

http://imagescanner.fujitsu.com/warranty.html

ATTENTION
For safety reasons, never attempt repairs by yourself.
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